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HALE Studio



Agenda

1. Omówienie zasad przejścia ze struktury źródłowej do struktury docelowej, w szczególności w kontekście 
harmonizacji danych przestrzennych na potrzeby inicjatywy INSPIRE

2. Konfiguracja środowiska narzędzia i jego omówienie, w tym omówienie możliwości readerów i writerów, 
ograniczenia, porównanie do innych narzędzi typu ETL

3. Przygotowanie zbioru, przeprowadzenie harmonizacji próbki danych
4. Mapowanie danych z kilku źródeł jednocześnie - przygotowanie danych i struktury do takiej operacji.
5. Wykorzystanie struktury i danych zapisanych w geobazie (*.mdb)
6. Masowe przetwarzanie formatów danych, struktur danych oraz układu odniesienia
7. Generowanie plików XML/GML
8. Transformacje schematów danych do innych formatów
9. Tworzenie sparametryzowanych szablonów hale, które będą mapować i-ty zestaw danych do zawartego w 

szablonie schematu.
10. Publikacja danych 
11. Rozszerzenia Hale Studio
12. Tworzenie projektów mapowania z parametrami, za pomocą Hale CLI
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Dane

W trakcie szkolenia będą wykorzystane realne dane pochodzące z rejestrów 
publicznych:

Geoserwis GDOŚ
Mapa Podziału Hydrograficznego Polski
Digitální báze vodohospodářských dat (Republika Czeska)
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Omówienie zasad przejścia ze struktury źródłowej do struktury docelowej, w 
szczególności w kontekście harmonizacji danych przestrzennych na potrzeby 

inicjatywy INSPIRE
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Definicja harmonizacji

Zapewnienie dostępu do danych przestrzennych w reprezentacjach, które 
umożliwiają łączenie tych danych w sposób spójny z innymi zharmonizowanymi 
danymi, korzystając z usług sieciowych oraz stosując wspólne specyfikacje 
produktów danych. 

(INSPIRE Generic Conceptual Model)
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Podstawy prawne
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Dyrektywa 2007/2/WE ustanawiająca infrastrukturę informacji przestrzennej we Wspólnocie Europejskiej 
(INSPIRE)

Rozporządzenie Komisji (UE) nr 1089/2010 z dnia 23 listopada 2010 r. w sprawie wykonania dyrektywy 
2007/2/WE Parlamentu Europejskiego i Rady w zakresie interoperacyjności zbiorów i usług danych 
przestrzennych (Dz.U. L 323 z 8.12.2010, s. 11–102).

Rozporządzenie Komisji (UE) nr 102/2011 z dnia 4 lutego 2011 r. zmieniające rozporządzenie (UE) nr 
1089/2010 w sprawie wykonania dyrektywy 2007/2/WE Parlamentu Europejskiego i Rady w zakresie 
interoperacyjności zbiorów i usług danych przestrzennych (Dz.U. L 31 z 5.2.2011, s. 13–34)

Rozporządzenie Komisji (UE) nr 1312/2014 z dnia 10 grudnia 2014 r. zmieniające rozporządzenie (UE) nr 
1089/2010 w sprawie wykonania dyrektywy 2007/2/WE Parlamentu Europejskiego i Rady w zakresie 
interoperacyjności usług danych przestrzennych (Dz.U. L 354 z 11.12.2014, s. 8–16)

"Państwa członkowskie są zobowiązane do udostępniania, w ramach tej infrastruktury, zbiorów danych, które 
dotyczą jednego lub kilku załączników do dyrektywy 2007/2/WE, oraz odpowiednich usług danych 
przestrzennych zgodnie z rozwiązaniami technicznymi służącymi interoperacyjności, oraz, gdy jest to 
wykonalne, harmonizacji zbiorów i usług danych przestrzennych." (art. 7 Dyrektywy)



Definicje z rozporządzenia

Pogrubionym pismem oznaczono pojęcia najważniejsze z punktu widzenia HALE.
Wszystkie definicje podano w ich dokładnym brzmieniu zgodnie z Rozporządzeniem Komisji (UE) nr 1089/2010 z dnia 23 
listopada 2010 r. w sprawie wykonania dyrektywy 2007/2/WE Parlamentu Europejskiego i Rady w zakresie 
interoperacyjności zbiorów i usług danych przestrzennych

„typ abstrakcyjny” (abstract type) oznacza typ, w przypadku którego nie można tworzyć instancji, ale który może posiadać 
atrybuty i role asocjacji;

„rola asocjacji” (association role) oznacza wartość lub obiekt, z którymi typ ma związek (art. 8 ust. 2 lit. b) dyrektywy 
2007/2/WE);

„atrybut” (attribute) oznacza cechę typu (art. 8 ust. 2 lit. c) dyrektywy 2007/2/WE);

„proponowany typ” (candidate type) oznacza typ, który jest już stosowany w ramach specyfikacji tematu danych 
przestrzennych wymienionego w załączniku I do dyrektywy 2007/2/WE, ale który zostanie w pełni określony w temacie 
danych przestrzennych wymienionym w załączniku II lub III do dyrektywy 2007/2/WE, do którego należy pod względem 
tematycznym;

„lista kodowa” (code list) oznacza otwarte wyliczenie, które może być rozszerzane;

„typ danych” (data type) oznacza deskryptor zbioru wartości, które wymagają opisania, zgodnie z ISO 19103; 7



Definicje z rozporządzenia

„wyliczenie” (enumeration) oznacza typ danych, w którym instancje tworzą stałą listę wartości wymienionych literalnie. 
Atrybuty wyliczenia mogą przyjmować jedynie wartości z tej listy;

„zewnętrzny identyfikator obiektu” (external object identifier) oznacza jednoznaczny identyfikator obiektu publikowany 
przez odpowiedzialny organ, możliwy do zastosowania przez aplikacje zewnętrzne celem odniesienia do obiektu 
przestrzennego;

„identyfikator” (identifier) oznacza niezależną językowo sekwencję znaków umożliwiającą identyfikowanie w sposób 
jednoznaczny i trwały tego, z czym jest powiązana, zgodnie z EN ISO 19135;

„tworzyć instancję” (instantiate) oznacza tworzyć obiekt zgodny z definicją, atrybutami, rolami asocjacji i ograniczeniami 
przyporządkowanymi typowi, dla którego instancja jest tworzona;

„warstwa” (layer) oznacza podstawową jednostkę informacji geograficznej, która może być uzyskiwana jako mapa z 
serwera zgodnie z EN ISO 19128;

„informacje na temat cyklu życia” (life-cycle information) oznaczają zbiór własności obiektu przestrzennego opisujących 
czasowe cechy wersji obiektu przestrzennego lub zmiany między wersjami;
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Definicje z rozporządzenia

„element metadanych” (metadata element) oznacza dyskretną jednostkę metadanych, zgodnie z EN ISO 19115;

„pakiet” (package) oznacza mechanizm ogólnego stosowania na potrzeby organizowania elementów w grupy

„rejestr” (register) oznacza zbiór plików zawierający identyfikatory przypisane do rejestrowanych elementów, wraz z 
opisami powiązanych elementów, zgodnie z EN ISO 19135;

„typ obiektu przestrzennego” (spatial object type) oznacza kategorię obiektów przestrzennych;

„styl” (style) oznacza przyporządkowanie sparametryzowanych symboli stosowanych przy sporządzaniu map do typów 
obiektów przestrzennych, ich własności i ograniczeń;
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Definicje z rozporządzenia

„podtyp” (sub-type of) oznacza związek między typem bardziej szczegółowym a typem bardziej ogólnym, gdzie typ 
bardziej szczegółowy jest w pełni zgodny z typem bardziej ogólnym oraz zawiera dodatkowe informacje (na podstawie 
ISO 19103);

„typ” (type) oznacza typ obiektu przestrzennego lub typ danych;

„voidable” (zastępowalne przez void) oznacza, że atrybutowi lub roli asocjacji może zostać przypisana wartość „void” 
(nieokreślona), jeżeli zbiory danych przestrzennych utrzymywane przez państwa członkowskie nie zawierają odpowiedniej 
wartości, bądź jeżeli nie jest możliwe wyprowadzenie odpowiedniej wartości z wartości istniejących przy rozsądnych 
kosztach. Jeżeli atrybut lub rola asocjacji nie są zastępowalne przez void, komórkę tabeli określającą „voidability” 
(zastępowalność przez void) pozostawia się pustą.
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Opis HALE Studio
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● Oprogramowanie utworzone w ramach projektu HUMBOLDT - pierwotna 
nazwa HUMBOLDT Alignment Editor - w celu ułatwienia przekształcania 
danych do schematów INSPIRE

● Napisane w języku Java, możliwe do uruchomienia we wszystkich głównych 
systemach operacyjnych (Mac, Linux, Windows)

● Aktualnie rozwijane przez firmę WeTransform (http://wetransform.to)
● Kod jest dostępny na licencji open source - GNU Lesser General Public 

License (LGPL) v3.0
● Dostępne jest wsparcie komercyjne od WeTransform
● Pobieranie wersji instalacyjnej - https://www.wetransform.to/downloads/, kodu 

źródłowego - https://github.com/halestudio/hale
● Dokumentacja http://help.halestudio.org/latest/index.jsp
● Szkolenie jest przygotowane dla wersji 3.5 - wydane 11 stycznia 2019

https://www.wetransform.to/downloads/
https://github.com/halestudio/hale
http://help.halestudio.org/latest/index.jsp


Schemat w HALE
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Schemat (Schema) jest opisem struktury 
danych. Wyróżniane są 2 typy schematów:

- Logical Schema - schemat 
konkretnego zbioru danych (pliku, 
dokumentu XML, bazy danych)

- Conceptual Schema - model 
koncepcyjny, opisuje dane bez 
wskazania konkretnej implementacji 
(np. model UML)

Do przeprowadzenia transformacji 
(harmonizacji) wymagane jest posiadanie 
Logical Schema.
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Schemat w HALE
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W procesie transformacji w HALE Studio schemat może być:
- zaimportowany z pliku definicji (np. XSD)
- zaimportowany z gotowych szablonów - presets - HALE posiada wbudowane 

gotowe definicje dla schematów aplikacyjnych INSPIRE
- odtworzony na podstawie istniejących danych (np. pliku SHP, bazy danych)

Dla projektu HALE musi zostać zdefiniowany schemat dla danych wejściowych 
(Source Schema) i wynikowych (Target Schema) by można było dokonać 
transformacji.
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Transformacja w HALE
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Parametry transformacji są określane jako 
Alignment i definiują zestaw przekształceń 
pomiędzy schematem źródłowym a 
wynikowym.

Pojedynczy Alignment składa się ze zbioru 
obiektów typu Mapping cell, które definiują 
przejście pomiędzy typami lub atrybutami 
wejściowymi i wynikowymi.

Zestaw parametrów transformacji oraz 
wskaźników do danych wejściowych i 
wynikowych nazywa się Alignment project i 
może być zapisany na dysku w formie pliku - 
analogicznie do projektów QGIS.
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Transformacja w HALE
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Mapping cell składa się z bytu wejściowego, bytu wyjściowego oraz funkcji 
przekształcenia. 

Przykłady: 

Funkcja Retype przenosi typ wejściowy "parki" na typ wyjściowy "ProtectedSite"
(funkcja Retype przeznaczona jest do mapowania typów danych)

Funkcja Rename przenosi wartość atrybutu "akt_prawny" na atrybut 
"legalFoundationDocument"
(funkcja Rename jest przeznaczona do mapowania atrybutów)
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Proces w HALE
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Proces harmonizacji danych w HALE składa się z następujących etapów:

● Import schematu danych źródłowych
● Import schematu danych wynikowych
● Import próbki danych źródłowych
● Identyfikacja typów danych wynikowych, które mogą być utworzone z danych 

źródłowych
● Stworzenie relacji pomiędzy typami wejściowymi a wynikowymi
● Identyfikacja i konfiguracja relacji pomiędzy wejściowymi a wynikowymi 

atrybutami
● Weryfikacja poprawności transformacji
● Eksport danych wynikowych



Konfiguracja środowiska narzędzia i jego omówienie, w tym omówienie 
możliwości readerów i writerów, ograniczenia, porównanie do innych narzędzi 

typu ETL)
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Instalacja HALE
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HALE Studio jest programem napisanym w Javie i jako taki wymaga wirtualnej 
maszyny Java do działania. 
Dystrybucja dla systemu Windows zawiera już wbudowaną maszynę wirtualną, 
więc nie ma potrzeby instalacji. W systemach MacOS i Linux wymagane jest 
Java JDK (nie JRE) w wersji min. 8. 

Szczegóły instalacji są podane w zeszycie ćwiczeń.



Definicja ETL
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Extract, Transform and Load - proces pozyskania danych dla baz danych, 
składający się z:

● pozyskania danych ze źródeł zewnętrznych,
● przekształcenia danych,
● załadowania danych do bazy docelowej.

ETL jest szerszym pojęciem od harmonizacji, wykorzystywany jest np. do 
migracji danych pomiędzy systemami, przy aktualizacji, do zasilania systemów 
klasy Business Intelligence.



Inne ETL
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Inne oprogramowanie typu ETL, które może być użyte do danych 
przestrzennych to na przykład:

● GDAL / OGR (open source)
● GeoKettle (open source)
● FME (komercyjny)



Formaty wejściowe
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HALE Studio obsługuje następujące formaty wejściowe schematów:

● XSD
● własny format Hale Schema Definition (w wariantach JSON i XML)
● CSV
● XLS i XLSX
● MDB 
● SQLite
● ESRI Shapefile
● WFS DescribeFeatureType
● PostGIS
● Microsoft SQL Server



Formaty wejściowe
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HALE Studio obsługuje następujące formaty wejściowe danych:

● XML i GML - także skompresowane programem gzip (to co innego, niż 
najpopularniejszy ZIP)

● CSV
● XLS i XLSX
● ESRI Shapefile
● MDB
● SQLite
● WFS GetFeature
● PostGIS
● Microsoft SQL Server



Formaty wynikowe
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HALE Studio obsługuje następujące formaty wynikowe schematów:

● deegree
● Hale Schema Definition (XML)
● Hale Schema Definition (JSON)

HALE nie umożliwia obsługi schematów koncepcyjnych, jak UML. Taką 
funkcjonalność miało narzędzie HUMBOLDT Conceptual Schema Transformer 
- niestety usługa sieciowa zakończyła działalność i narzędzie już nie jest 
dostępne.



Formaty wynikowe
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HALE Studio obsługuje następujące formaty wynikowe danych:

● CSV
● PostGIS
● Microsoft SQL Server
● GML
● GeoJSON
● SQLite
● XLS
● XML użytkownika
● WFS-T



HALE vs inne ETL
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Cecha HALE Studio GeoKettle FME OGR

Wbudowane schematy 
INSPIRE

TAK NIE TAK NIE

Możliwość odczytu i 
zapisu z i do WFS

TAK NIE TAK TAK

Dostępna usługa 
chmurowa

TAK - do przechowywania 
projektów i publikacji 
danych (hale connect)

NIE TAK - do 
przeprowadzania 
transformacji w chmurze 
(FME Cloud)

NIE

Dostępne formaty danych 10 formatów 45 formatów 335 formatów 45 formatów

Dostępne funkcje 
geoprocessingu

6 funkcji 27 funkcji 80 funkcji 4 funkcje

Cena 0 0 2000 € 0

Główne zastosowanie Harmonizacja danych 
INSPIRE

Migracja danych 
przestrzennych

Migracja i przetwarzanie 
danych przestrzennych

Konwersja formatów 
danych przestrzennych



Przygotowanie zbioru, przeprowadzenie harmonizacji próbki danych
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Informacje wstępne
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Ćwiczenie "Harmonizacja próbki danych" będzie polegało na wykonaniu 
harmonizacji dla danych o obszarach Natura 2000 pochodzących z Geoserwisu 
GDOŚ.

Metodyka harmonizacji została oparta o publikację:

Krawczyk A., Garguła A., 2018, Harmonization of Polish Natura2000 data sets 
with the protected sites data schema of inspire directive in the environment of 
Humboldt Alignment Editor (HALE), Geoinformatica Polonica 17:7-15
DOI: 10.4467/21995923GP.18.001.9158



Interfejs HALE
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schemat 
wejściowy

schemat 
wynikowy

mapowanie

dziennik 
komunikatów



Schemat wejściowy

Import -> Source schema
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Schemat wejściowy może być 
zadany poprzez definicję 
schematu XSD lub istniejący zbiór 
danych (plik lub baza danych). W 
przypadku obszarów Natura 2000 
rozpowszechnianych w formie 
plików SHP, właściwą opcją 
będzie import z pliku - 



Inspekcja schematu
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Import SHP jako schematu powoduje załadowanie 
wyłącznie schematu- same dane nie zostaną 
wczytane.

Symbol        oznacza atrybut tekstowy

       oznacza atrybut liczbowy

      oznacza geometrię



Import danych
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Import danych musi być wykonany 
po wczytaniu schematu 
wejściowego. Domyślnie 
importowana jest próbka 500 
pierwszych obiektów. Wielkość 
próbki można ustawić w oknie 
Window -> Preferences -> Project 
-> Source data.



Inspekcja danych

Dostępne są 2 widoki dla danych, widok tabeli 
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Inspekcja danych

oraz widok mapy      - przełącznik widoków znajduje się w prawym 
górnym rogu ekranu.
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Inspekcja danych

34

Prezentacja atrybutów przykładowego obiektu źródłowego



Import schematu INSPIRE
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File -> Import -> Target Schema
Schematy INSPIRE są dostępne w zakładce 



Inspekcja schematu INSPIRE
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Schemat "INSPIRE Protected Sites Simple 4.0"

Schematy INSPIRE są schematami tzw. 
Complex Features, co oznacza, że atrybuty 
mogą być zagnieżdżone - atrybut może 
zawierać swoje własne atrybuty. 

Taka struktura jest prosta w realizacji w 
formatach XML (GML) i JSON (GeoJSON), ale 
nie pasuje dobrze do plików płaskich np. SHP i 
relacyjnych baz danych.



Utworzenie mapowania
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Po wczytaniu schematu wejściowego i wynikowego, można przystąpić do 
przygotowania mapowania (Alignment).

Wczytanie danych źródłowych nie jest obowiązkowe, ale umożliwia podgląd 
wyników i ewentualnych błędów na bieżąco.

Pierwszym krokiem jest mapowanie typów danych. Najprostszym przykładem jest 
przeniesienie jednego zbioru wejściowego w jeden zbiór zharmonizowany - 
zostanie w tym celu użyta funkcja Retype.



Mapowanie typów
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Należy kliknąć typ źródłowy w panelu Source, typ wynikowy w panelu Target i 
kliknąć przycisk       , wybrać Retype.



Mapowanie typów
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Funkcja Retype dokonuje mapowania 
jednego typu wejściowego na jeden typ 
wynikowy. Inne opcje to:

Groovy Retype - mapowanie 1:1 
wspomagane skryptami w języku Groovy
Groovy Merge - scalenie n:1 wspomagane 
skryptami w języku Groovy
Merge - scalenie n:1



Mapowanie atrybutów

Dodanie funkcji Retype dodaje Mapping Cell do tabeli mapowań - można 
wówczas rozpocząć dodawanie kolejnych mapowań dla atrybutów.
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Mapowanie atrybutów może być:

- z schematu wejściowego do wynikowego
- przypisanie wartości stałej do schematu wynikowego



Mapowanie atrybutów

Mapowanie atrybutów polega na wyborze atrybutu w schemacie źrodłowym, 
następnie wyborze atrybutu w schemacie wynikowym, kliknięciu       i wyborze 
funkcji mapowania. 

Najprostszą funkcją jest Rename, czyli przeniesieniu wartości atrybutu A w 
schemacie wejściowym w niezmienionej formie do atrybutu B w schemacie 
wynikowym. Przykład - "nazwa" na "name"
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Walidacja

Po każdej edycji mapowania następuje wykonanie transformacji i jej walidacja. 
Błędy walidacji można przeczytać, klikając dwukrotnie w 
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Mapowanie atrybutów

Minimalny zestaw mapowań, jaki pozwala na poprawne zaliczenie walidacji to:
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Szczegółowy wykaz znajduje się w zeszycie ćwiczeń.



Podgląd wyniku

Ustawiono podgląd mapy w kolumnach - po lewej stronie dane oryginalne, po 
prawej zharmonizowane.
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Mapowanie stałych
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Aby przypisać wartość stałą do danych wynikowych, należy zaznaczyć atrybut w 
schemacie wynikowym, następnie kliknąć      między panelami Source i Target i 
wybrać Assign.



Mapowanie stałych
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Dla atrybutów, dla których wartości są typu enumeration (niezmienny słownik) 
HALE pokaże listę dopuszczalnych wartości.



Mapowanie list kodowych
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W przypadku atrybutów, gdzie lista wartości to Enumeration (katalog zamknięty), 
lista możliwych wartości jest dostępna od razu w HALE.

Dla katalogów otwartych (code list) konieczny jest wcześniejszy import listy z 
rejestru INSPIRE. Import odbywa się poprzez narzędzie Import -> Code list 
->From INSPIRE Registry.

Gdy do danych wynikowych będzie przypisana jedna, stała wartość z listy 
kodowej należy użyć Assign, natomiast w przypadku mapowania słownika 
wartości na listę kodową należy użyć funkcji Classification.



Import list kodowych
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Mapowanie danych z kilku źródeł jednocześnie - przygotowanie danych i 
struktury do takiej operacji.

49



Przypadki
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● jeden schemat INSPIRE, jedna klasa INSPIRE, wiele plików źródłowych o 
identycznym schemacie

 
- wówczas wystarczy importować schemat źródłowy jeden raz i kolejne dane 

dodawać za pomocą funkcji Import source data

● jeden schemat INSPIRE, jedna klasa INSPIRE, wiele plików źródłowych o 
różnym schemacie

- wówczas należy importować schemat wejściowy dla każdego źródła danych 
(Import source schema) i wykonać mapowanie Retype dla każdego źródła 
osobno, wybierając ten sam schemat docelowy

● jeden schemat INSPIRE, wiele klas INSPIRE, wiele plików źródłowych

- wówczas należy wykonać osobne mapowania dla każdej relacji.



Przypadek 1
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Mapowanie prawie nie różni się od mapowania dla pojedynczego pliku - jedyna różnica to wykorzystanie 
atrybutu filename 

Mapowanie dwóch plików SHP z obszarami OSO i SOO na klasę INSPIRE ProtectedSite



Przypadek 2
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Mapowanie dwóch plików SHP (czeska i polska sieć rzeczna) na jedną klasę INSPIRE Watercourse

Występują 2 schematy źródłowe i dwie operacje Retype kierujące dane do tej samej klasy



Przypadek 3
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Mapowanie plików "rzeki_o.shp" na klasę Watercourse, "zlew_el.shp" na 
DrainageBasin oraz "jeziora.shp" na klasę StandingWater

Występują 3 schematy wejściowe i 3 klasy wynikowe



Wykorzystanie danych i struktury zapisanych w bazach danych
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Geobaza MDB
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Import struktury i danych z geobazy osobistej MDB odbywa się podobnie do importu 
schematu z plików SHP, to jest przez narzędzie Import -> Source schema -> From 
file. Jedyną różnicą jest dialog podania loginu i hasła, które należy pozostawić puste.



Geobaza MDB
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Dane należy załadować narzędziem Import -> Source data -> From file.



Baza SQLite

57

Bazy SQLite i SpatiaLite teoretycznie są obsługiwane przez HALE, w praktyce nie 
udało się importować żadnego rzeczywistego przykładu.



Baza PostGIS
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Do importu struktury i danych z 
bazy PostGIS (lub Microsoft SQL 
Server) służy opcja From 
Database (JDBC).



Baza PostGIS

59

Każda tabela z bazy jest importowana jako 
jedna klasa źródłowa.

Dalszy proces mapowania przebiega 
identycznie jak w przypadku mapowania z 
danych zapisanych w pliku.



Generowanie plików GML i XML

60



Dostępne opcje
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File -> Export -> Transformed data

GML (FeatureCollection)

GML (Inspire SpatialDataSet) - przestarzały

GML (WFS 2.0 FeatureCollection)

XML użytkownika



XML użytkownika
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Do wyboru z listy elementów XML 
OpenGIS



GML FeatureCollection
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Opcje obowiązkowe: 

● wybór pliku docelowego

● wybór układu współrzędnych, kolejności wierzchołków, prefiksu dla definicji układu współrzędnych



GML FeatureCollection
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Opcje dodatkowe:

- pretty print - formatowanie 
drzewa XML (znaki nowej linii, 
wcięcia)

- redukcja 1-elementowych 
geometrii Multi do prostych 
geometrii

- ominięcie atrybutu nilReason 
(przyczyna braku danych) dla 
niepustych atrybutów

- wybór formatowania wartości 
dziesiętnych



GML FeatureCollection
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Partycjonowanie danych - zapis wyniku do 
wielu plików GML

Dostępne opcje to:

- podział co każde N obiektów
- podział na klasy obiektów
- podział przestrzenny (na arkusze)



Transformacje schematów danych do innych formatów
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Eksport schematu danych
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File -> Export -> Source schema

File -> Export -> Target schema



Eksport schematu
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Jako formaty wynikowe dostępne są wyłącznie formaty czytelne dla HALE 
lub deegree. Nie ma możliwości eksportu schematu XSD z HALE 
Studio.



Eksport mapowania
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Większe możliwości występują w zakresie eksportu mapowania - możliwe są formaty 
HALE, ale też XSLT, CSV, XLSX oraz dokumentacja graficzna (HTML z obrazem 
SVG)



Dokumentacja mapowania
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Widok przykładowego eksportu schematu mapowania do HTML+SVG - do przeglądania w przeglądarce 
internetowej. 



Przygotowanie szablonów mapowania z parametrami
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Przygotowanie szablonu
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Przygotowanie szablonu do zautomatyzowanego przetwarzania nie różni się w 
większości od zwykłego projektu mapowania, z wyjątkiem ustawień eksportu.

Z uwagi na dużą liczbę parametrów dostępnych dla eksportu, HALE umożliwia 
tworzenie tzw. export configurations (dokumentacja posługuje się pojęciem export 
preset) które w trakcie automatycznego przetwarzania będą wywoływane po nazwie.



Export preset
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File -> Export -> Create custom date export

Tworzenie szablonu eksportu przebiega tak samo, 
jak konfiguracja eksportu, za wyjątkiem tego, że 
zamiast podania nazwy pliku wynikowego podaje się 
nazwę i opis szablonu, a sam eksport nie jest 
wykonywany.



Wykorzystanie projektów mapowania z parametrami w Hale CLI
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Hale CLI

CLI jest skrótem od Command Line Interface.

HALE Studio po przygotowaniu projektu i szablonu eksportu może zostać 
wykorzystane do wykonania transformacji bez środowiska graficznego - w 
sposób zautomatyzowany.

Istnieją 4 sposoby na wywołanie HALE z linii komend:

- dla wszystkich platform: poprzez wirtualną maszynę Javy
- dla Windows: poprzez plik HALE.exe
- dla Linux/Mac: poprzez osobny program hale-cli 

(https://github.com/halestudio/hale-cli)
- poprzez kontener Docker
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https://github.com/halestudio/hale-cli


Zastosowanie CLI
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Należy uruchomić wiersz polecenia (cmd), a następnie przeciągnąć do niego 
plik HALE.exe

a następnie dopisać parametry obowiązkowe: -nosplash -console -application hale.transform



Zastosowanie CLI
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Parametry:

-project - obowiązkowo: ścieżka do projektu
-source - obowiązkowo: ścieżka do danych źródłowych (źródło zdefiniowane w 
projekcie jest pomijane)
-filter - opcjonalnie: filtr do danych źródłowych w formacie CQL
-target - obowiązkowo: ścieżka do pliku wynikowego
-preset - opcjonalnie: nazwa szablonu eksportu
-validate - opcjonalnie: oznaczenie walidatora

Szczegółowy opis transformacji z linii komend znajduje się w zeszycie ćwiczeń.



Masowe przetwarzanie danych
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Przetwarzanie masowe

HALE Studio nie posiada własnego systemu masowego przetwarzania danych. 

Niemniej jednak można wykorzystać w tym celu plik Batch w Windows, lub skrypt 
shell w innych systemach. 
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Przetwarzanie masowe
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for %%i in (*.shp) do 
    C:\Users\inspire\WeTransform\HALE.exe -nosplash 
-console -application hale.transform -project 
projekt.halez -source %%i -target %%i.gml -preset GML4258 

Skrypt należy zapisać w pliku z rozszerzeniem .bat, następnie uruchomić dwuklikiem lub z 
poziomu wiersza poleceń.

Pętla po wszystkich plikach SHP w katalogu,
przypisuje każdy plik do zmiennej %%i

Wywołanie HALE

ścieżka projektu
źródło (ze zmiennej)

wynik (ze zmiennej + rozszerzenie GML)

nazwa 
szablonu



Publikacja danych
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Możliwości publikacji
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Dane zharmonizowane w HALE Studio można automatycznie opublikować w:

GeoServer
XtraServer
deegree
usłudze Hale Connect



GeoServer
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Do eksportu do GeoServer jest niezbędna instalacja rozszerzenia 
AppSchema po stronie GeoServer.

Opis: https://docs.geoserver.org/stable/en/user/data/app-schema/index.html
Pobieranie: 
https://sourceforge.net/projects/geoserver/files/GeoServer/2.15.2/extensions/
geoserver-2.15.2-app-schema-plugin.zip/download

Instalacja polega na pobraniu archiwum, rozpakowaniu go i skopiowaniu do 
katalogu GeoServera i podkatalogu /WEB-INF/lib.

WAŻNE: po instalacji należy zapewnić min. 1 GB pamięci (Java Heap 
Space) dla GeoServer, inaczej eksport się nie powiedzie z błędem Out of 
Memory.

https://docs.geoserver.org/stable/en/user/data/app-schema/index.html
https://sourceforge.net/projects/geoserver/files/GeoServer/2.15.2/extensions/geoserver-2.15.2-app-schema-plugin.zip/download
https://sourceforge.net/projects/geoserver/files/GeoServer/2.15.2/extensions/geoserver-2.15.2-app-schema-plugin.zip/download


GeoServer
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Zasadą działania publikacji danych za pomocą HALE Studio jest wykorzystanie 
już istniejącego rozszerzenia do obsługi schematów aplikacyjnych - App Schema.

W przypadku publikacji na serwer wysyłana jest jedynie transformacja danych, 
natomiast nie wysyła się żadnych danych wynikowych. Generowane przez 
GeoServer pliki GML są przykładem transformacji na żądanie - on the fly, w 
warstwie bazodanowej dane są przechowywane w dotychczasowym schemacie, 
który nie musi być zgodny z INSPIRE.

Wadą tego podejścia jest obsługa tylko jednego formatu danych źródłowych - 
musi być to baza PostGIS.



GeoServer

Po stronie HALE Studio należy zainstalować rozszerzenie GeoServer: 

Help -> Install New Software…

85

Opis procesu publikacji znajduje 
się w zeszycie ćwiczeń.



Rozszerzenia HALE Studio
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Dostępne rozszerzenia
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GeoServer AppSchema
FME Plugin
XtraServer Plugin



Rozszerzenie FME
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HALE Studio może współpracować z FME. Ideą rozszerzenia jest dodanie 
nowego formatu wynikowego - HALE Schema Transformation do FME.



Rozszerzenie XtraServer
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XtraServer jest produktem firmy 
interactive instruments, który służy 
do publikacji usług sieciowych WMS i 
WFS.

Aby wykorzystać rozszerzenie należy 
włączyć tryb "XtraServer 
compatibility mode" w HALE.

Po utworzeniu mapowania 
(Alignment) można je wyeksportować 
w formacie XtraServer.



Groovy

90

Groovy jest językiem skryptowym działającym w środowisku wirtualnej 
maszyny Java.

Może być użyty do tworzenia własnych funkcji w HALE Studio (tak jak Python w 
QGIS).
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Dziękuję za uwagę


